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ABSTRACT 

 

This internship is on a study of basic ISP networking with Mikrotik Router configuration. 

Mainly I am working on Mikrotik OS based router configuration. Mikrotik has been established 

in 1996. This router is mainly easy to use for bandwidth management. Actually a Mikrotik 

Router is cost-efficient and easy access that can be used for small and big network management. 

Our Internet Service Provider (ISP) Company especially uses Mikrotik Router in this sector. 

These functions include IP addressing, IP distribution, Firewall, Nat, Routing, Bandwidth 

control, Point to Point Tunneling Protocol (PPTP), Domain Name System (DNS) server, 

Dynamic Host Configuration Protocol (DHCP) server, File Transfer Protocol (FTP) server, Point 

to Point Protocol Over Ethernet (PPPoE), Hotspot and many other features. In this sector we are 

using Cisco router, Cabling and Linux operating system etc. Nowadays, people of all over the 

world use the internet in daily life. A network provides the internet service from computer to 

computer and other networking devices. So, Networking is so much important fact right now. 

Nowadays internet is using on Software based application, E-Commerce website, Robotic, 

Internet of things (IoT). Its use is increasing day by day. They provide various advantages, For 

example- instant messaging, Parallel computing, Video conference, Interaction with other users 

using dynamic web pages, Sharing information by using the internet or web. 
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CHAPTER 1 

Introduction 

 

1.1 Introductions: 

Now this time you can search any Resource through the Internet all over the World. 

Nowadays a huge number of people use internet Resource and digital technology. We do 

nothing for internet communication servers. This is why Dynamic Host Configuration 

Protocol (DHCP) and Domain Name System (DNS) servers are very important for 

networking Technology. This day is currently working with Small or Large Organization, 

Bank services, etc. through the software to connect to the Internet. the internet huge use  

banking services on most of the internet such as Short message service (SMS), Banking 

online, Debit card service, Credit card Service, Online Transaction etc. When a 

Organization uses internet, you can easily Communicate and Maintain. This Report is 

about PC networking, server configuration, server Security, microtic OS based Routers, 

Firewalls, Bandwidth control, Backholes Links, Wireless access points, Hotspot 

gateways etc. We can learn to manage the network using simple microtic commands or 

Winbox graphically. 

 

1.2  Motivation: 

As a Mikrotik Routing  system and network Administrator, there‟s a huge amount of Job 

post all over the world. I think, Mikrotik Operating system is very easy to use and when 

Internet Service provider (ISP) Organization use Mikrotik Operating system, then you 

can easily maintain user or Employ and control and share bandwidth. I think, I can 

successfully my experience on Mikrotik with the help of Prisma Digital Network 

Limited. 

 

1.3  Objectives: 

The main Objective of higher Education is to gain Knowledge. I choose an Internship on 

Networking on mikrotik Platform because Nowadays, a huge amount of job 
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Opportunities all over the world and I gain practical experiences on prisma Digital 

Network Limited. I will try my level best to present my practical Knowledge  

Mikrotik Router plays a role in a Data center because in Mikrotik Router Management 

bandwidth control is very easy. That‟s why I select this topic for an Internship. 

• Install Mikrotik operating system OS base (OS) 

• Configure ISP server with Win dox 

• Maintain Bandwidth with Win dox 

• Maintain user or Employ with Win dox 

 

 

1.4 Introduction to the Company: 

Prisma Digital Network Limited is the largest Internet Service Provider (ISP) in 

Bangladesh. At 2005, our company started internet service. We provide internet fix for 

home and business users according to the need of customer‟s objective. We have 14 years 

of support in our country. We are always one step ahead than others in this competitive 

field and will strive to stay. Our ISP company gives 24/7 customer services and high 

speed internet service in Bangladesh. Our internet users are always happy to use our 

services. We work with a variety of national challenge and global association and picked 

up the stable stage. 

 

1.5 Report Layout: 

The report is as follows 

Chapter:-1 I Discus the internship, the Inspiration for the internship and the Acquaintance 

with the organization. Chapter:-2 I Discus IT services and what role Mikrotik has played 

in the job Market. Chapter:-3 I Discus the day-to-day work and Activities, events and 

Challenges. Chapter:-4 I have Discus d in detail about Skills, Smart Planning and 

Reflection. Chapter:-5 I have Discus d the Conclusion and future Opportunities. 
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CHAPTER 2 

Organization 

 

2.1 Introduction: 

Prisma Digital Network Limited is one of the best, Largest and oldest ISP company in 

Bangladesh. The company provides internet service and solution since 2005. Our 

company uses fiber optic and wireless communication infrastructure and also using 

highly efficient networking device and technology. Our service team is highly trained and 

our users are always happy to use our service. Prisma Digital Network Ltd. has very 

strong security. Professional engineering and management teams are certified and 

associated. CISCO, JUNIPER, Mikrotik, BDCOM, FREEBSD. Prisma Digital Network 

Ltd. promotes 2 major platforms internship for education purpose and networking sector.    

 

2.2 Product for Marketing: 

Prisma Digital Network Limited is the largest internet service provider (ISP) in 

Bangladesh. This Organization is one of the most respected Organizations for internship, 

providing Broadband connections, Information Technology (IT), Relative services and 

solutions since 2005. The Prisma Digital Network Ltd. 24 hour‟s service and high-speed 

data service through the internet. Mostly it offers high-speed internet service to 

Residential and Corporate customer. 

1. Network Installation. 

2. Protected Ring Network. 

3. Manage Hosting. 

4. Multiple Upstream. 

5. ISP Support. 

6. Corporate level Internet Solution. 
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2.3 Organizational Structure of Prisma Digital Network Limited: 

 

Figure 2.3.1: Organization of Prisma Digital Network Limited 
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CHAPTER 3 

Internship Roles & Responsibilities 

 

3.1 Daily Task and Activities:  

●Month - 1:  In  the  first  month  of  my  internship at  Prisma Digital Network Limited  

I   have learned and performed the following tasks:  

es 

to Mikrotik OS 

Mikrotik Router OS using VMware. 

 router configuration 

 

 to configure your LAN Network 

●Month - 2: In this month I have learned and performed the following tasks:  

Firewall and NAT Configuration 

-IP Configuration 

nfiguration 

●Month – 3: In this month of I have learned and performed the following tasks:  

 

ode Configuration 

Website Blocking Configuration 

●Month – 4: In this month of I have learned and performed the following tasks:  

t Configuration 

onfiguration 

Bind MAC Address 
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3.2 Events and Activities: 

The main goal is to prepare for the temporary position, when some problems are 

encountered in the entry-level position; At this point, it is imperative to prepare to solve 

the problem. Identifying this problem and activators can address it. I have practically 

learned this internship program from Prism Digital Network Limited and have performed 

in real-life in the following tasks. es for all class of IP with Subnet 

ik Router and Configuration 

about Network Components 

3.3 Project Task and Activities: 

 

 

3.3.1 About IP Address 

IP means internet protocol. The network defines an IP address in two elements: Part of 

the community and host range. The IP address contains 4 octets and each octet is eight-

bit, it means the IP address's total bit is 32. For A class IP, the first octet is a network and 

the last 3 octets are the host. For 'B' class, the first 2 octets are network and the last 2 

octets are hosts, and for 'C' class, first 3 octets are the network and the last octet is the 

host and D, E classes are multicast. 

Class Range Private IP Public IP 

A 0-126 
10.0.0.0 to 

10.255.255.255 

1.0.0.0 to 9.255.255.255 

11.0.0.0 to 126.255.255.255 

B 128-191 
172.16.0.0 to 

172.31.255.255 

128.0.0.0 to 171.255.255.255 

172.0.0.0 to 172.15.255.255 

173.0.0.0 to 191.255.255.255 

C 192-223 
192.168.0.0 to 

192.168.255.255 

192.0.0.0 to 192.167.255.255 

192.169.0.0 to 192.169.255.255 

D 224-239 Multicast Address 

E 240-255 Restricted 
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3.3.2 Introduction of Mikrotik 

Mikrotik is a Latvian company founded in 1996 to develop routers and wireless ISP 

systems. Mikrotik now provides hardware and software for Internet connection in most 

countries of the world. 

3.3.3 PC Based Installation of Mikrotik Router OS Using VMware 

Requirement Software: 

• VMware Workstation Application 

• MikroTikOS ISO File 

• WinBox 

 

Mainly, this software is used for Mikrotik Router management and maintenance. 

 

Figure 3.3.3.1: Software Icon for VMware, Mikrotik ISO, Winbox 

 

Here, I am showing the installationguideline step by step: 

Step 1: First we need to install VMware> open it, then click File> New Virtual 

Machine> Next> Next> OK. 

 

Step 2:Create a new virtual machine. 
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Figure 3.3.3.2: VMware Workstation 

Open VMware Workstation and click file option and select a new virtual machine and 

apply. 

 

Step 3:Select virtual machine hardware compatibility and next.Step 4:Guest operating 

system installation>Select, I will install the operating system later>Next.Step 5:Select a 

guest operating system>Select, Other>Version>other>next. Step 6:Give me a name for 

the virtual machine and select the file location.>Write a virtual machine name: Example 

of: Mikrotik>Location: Example of: C:\Users\MD BABU\Documents\Virtual 

Machines\Mikrotik>Next. Step 7:Select the processor's configuration as needed>Write a 

Number of processor: Example of: 1>Number of cores per processor: Example of: 

1>Next.Step 8:Let's select the range of memory for the virtual machine >Write 

a Memory for this virtual machine: Example of: 1024 MB>Next. Step 9:Let's select 

the range of disk capacity for the virtual machine>Write a Maximum disk size 

(GB): Example of: 10> select split virtual disk into multiple files>Next. Step 10:Specify 

disk file location>Write a disk file: Example of: Mikrotik.vmdk>Next.Step 11:Ready to 

create a virtual machine>If I verify the information, click on the Next option.Step 

12:Select Virtual Machine settings>Double click, “Edit Virtual Machine settings”.Step 

13:Edit Virtual Machine settings.>Click on, Add and ok.Step 14:Add hardware 

wizard>Click on, “Network Adapter>Finish>Ok”.Step 15:Now select ISO file and > 

virtual machine name and also choose a location, where the machine will be installed >. 

Hardware requirement >Select all with, “press „a‟>press „n‟>press „y‟>Enter”. 

 

Step 15:Install successful Mikrotik OS. 
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Figure 3.3.3.3: Mikrotik OS Command-line interface (CLI) Mode 

 

3.3.4 Mikrotik Router Configuration: 

 

Figure 3.3.4.1: Network Topology of Mikrotik 

First open the Winbox software, type the username “admin” and enter without any 

password. 

Step 1: First, let's specify the name of the port of the Mikrotik router. 
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Figure 3.3.4.2: Mikrotik Router Interfaces 

First we define the name of each interface.  I type in the way the name is given in the 

picture above. 

 

Step 2: To configure the Mikrotik Router, apply the IP address provided by the ISP cutter 

to the specified Ethernet port and apply IPs for the local area network and the 

metropolitan area network. 

 

 

Figure 3.3.4.3: IP Addressing 

To create an IP address, first you have to go from IP to Address, then click on the Add 

button, input the data as shown in the picture above, and click OK. 

 

 

Step 3: Let's connect Domain Name System (DNS) server. 
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Figure 3.3.4.4: Domain Name System (DNS) Server 

From IP to DNS, click on add button from here and click OK with the required server IP. 
 

Step 4: Let's configure the Network Address Translation (NAT) from the firewall. 

 

Figure 3.3.4.5: Network Address Translation from the firewall 

To configure Nat, first go to IP, firewall, click on next Nat, select chain in general 

options, select source net and out interface wan, click apply, click OK. 

 

 

Step 5:Here the masqueradeis selected from the action options. 
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Figure 3.3.4.6: Firewall of Action 

Next, click on, “Action>Select=masquerade>Apply>Ok”. 
 

Step 6:Let's configure the IP address to routes. 

 

Figure 3.3.4.7: IP Routing 

 

Now, click on, “IP>Routes>Routes>Add>General>Gateway: Example of: 

172.16.15.1>Apply>Ok”. 
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Step 7:Check whether the router has internet or Command-line interface (CLI) appliance 

on the terminal option of the router. 

 
Figure 3.3.4.8: IP Ping to WinBox Terminal 

Microtic Router Configuration Completed Now an IP Pink Marriage will see if the 

configuration is OK.  First we have to go to the new terminal. Now type and enter as in 

the picture above. 

 

3.3.5 Static-IP Configuration in Mikrotik Router: 

Step 1: The LAN IP address is assigned first. 

 

Figure 3.3.5.1: IP Addressingfor Static IP 
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To create an IP address, first you have to go from IP to Address, then click on the Add 

button, input the data as shown in the picture above, and click OK. 

 

Step 2: Apply to a static IP user's personal computer. 

 

 

Figure 3.3.5.2: TCP/IPv4 Configuration 

To configure the static IP, first go to PC Settings Next Network Next Change Address 

Setting Next Local Area Connection Next Properties Next Double click on IPv4 and 

input data as shown above and click Apply OK. 

Step 2: Let's check the user's Internet through the command prompt(Executable 

name: cmd.exe). 

 

Figure 3.3.5.3: CMD mode of the user's PC 
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Press the PC start button> search> CMD and inter>ping 192.168.1.1 –t inter. 

3.3.6 Queue Configuration: 

The best way to manage the bandwidth of all types of IP allocation systemis to configure 

a queue. 

 

Figure 3.3.6.1: Network Topology of Queue Configuration 

User1: 5MB Upload and 5MB Download 

User2: 8MB Upload and 8MB Download 

 

Step 1: Add IP address for Local Area Network (LAN).  

 

Figure 3.3.6.2: Add IP Address 
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To create an IP address, first you have to go from IP to Address, then click on the Add 

button, input the data as shown in the picture above, and click OK. 

 

Step 2: Create a user and set the bandwidth limitation.  

 

Figure 3.3.6.3: Simple Queues 

To create a new user, first go to the Queue option.  From Queue to Simple Queue then 

click on Add from General Options as required name target IP and target upload, target 

download bandwidth select and click OK 

 

Step 3: Let‟s see the MAC address “User1” 

Figure 3.3.6.4: Address Resolution Protocol (ARP) 
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Step 4:Let's check the user's internet through the command mode. 
 

 
Figure 3.3.6.5: Network Connection Details 

Press the PC start button> search>CMD and inter>ping 192.168.1.1 –t inter. 

 
 

Queues of Parent Concept: 

Step 1: Creates a parent concept's blog diagram 

 
Figure 3.3.6.6: Network Topology of Parent Concept 

Step 2: First we create two user blogs and create separate users under each block. 
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Figure 3.3.6.7: Simple Queues of Parent 

At first Click on, "Queues>Simple Queues>General>Name: Example of: Management 

Blog>Target: Example of:10.20.20.0/24>Apply>Ok". 

In the same way, we create the next blog and create a user of management blog. 

Next Click on, “Queues>Simple Queues>General>Name: Example of: User1>Target: 

Example of: 10.20.20.2>Advanced >Parent: select management blog>Apply>Ok". 

 

3.3.7 DHCP Server Configuration with Mikrotik Router: 

Step 1: Select the interface for the Dynamic Host Configuration Protocol(DHCP) server 

configuration. 
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Figure 3.3.7.1: DHCP Server Interface 

Click on, IP>DHCP Server>DHCP>DHCP Setup>DHCP Server Interface: Select 

interface>Step 2: Input a DHCP address space for the Dynamic Host Configuration 

Protocol(DHCP) server.> DHCP Address Space: Example of 192.168.10.0/24>Step 3: 

Input a gateway for Dynamic Host Configuration Protocol(DHCP) network.> Gateway 

for DHCP Network: 192.168.10.1>Step 4: Input an address to give out for the Dynamic 

Host Configuration Protocol(DHCP) server.>Addresses to Give Out: 192.168.10.100-

192.168.10.254>Step 5: Input a Domain Name System (DNS) server for the Dynamic 

Host Configuration Protocol(DHCP) Setup.> DNS Servers: Example of 8.8.8.8 and 

124.6.224.4>Step 6: Input a lease time for the Dynamic Host Configuration 

Protocol(DHCP) Setup.>Lease Time: Example of 00:10:00> 

 

Step 7:Let‟s see, if the Address Resolution Protocol (ARP) matches the user‟sMedia 

Access Control (MAC) address.  

 

 

Figure 3.3.7.2: ARP for DHCP Configuration 
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From PC setting click on network and go to local area connection from change adapter 

setting >Disable and enable>Double Click on Local Area Connection>Details>Show all 

information. 

 

 3.3.8 Bridge Configuration with Mikrotik Router: 

Step 1: Ethernet ports of Mikrotik Router: 

 

Figure 3.3.8.1: Interface List of Bridge 

Click on, Interfaces and show all Ethernet ports. 

Step 2: Set up a bridge configuration.  

 

Figure 3.3.8.2: Create Bridge Name 
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To create a bridge, first you have to go to the bridge, click on the add button, go to the 

general option, give the bridge a name as required and select the bridge by type, then 

click OK. 

Step 3: Let‟s add ports of bridge connection. 

 

Figure 3.3.8.3: LAN Configure of Bridge Port 

Now click, "Bridge>Ports>Add>General>Interface: Select interface>Bridge: bridge 

1>Apply>Ok". 

Step 4: Finally,apply bridge configuration for address lists. 

 

Figure 3.3.8.4: Change Interface 
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Final step, "Address list to select interface and apply> Ok" 

 

 

3.3.9 Website Blocking Configuration: 

Step 1: Create layer 7 protocols to block the website. 

 

Figure 3.3.9.1: Firewall L7 Protocol 

To create Layer Seven protocol, first go to IP from the firewall and then click on Layer 

Seven protocol.  Now click on the plus username and input the data in the same way as 

given in the picture. Click on Apply. 

 

Step 2: Create a filter rules to block the website. 

 

Figure 3.3.9.2: Firewall Rule 
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 Let's make a filter rolls.  First let's click on firewall from IP.  Click Add from Filter 

Rules. Now select Forward to Chain from General Options and type the source address 

and click Apply. 

 

3.4.1Hotspot Server Configuration: 

Step 1: Create an IP pool for hotspot server. 

 

Figure 3.4.1.1: IP Pool Configuration 

Let's create a pool for the hotspot server. First we have to go from IP to pools and click 

on add as required. 

 

Step 2: Select the interface for the hotspot server. 

 

Figure 3.4.1.2: Hotspot Interface 

To create a hotspot server, first click on hotspot from IP option and then click on hotspot 

setup from servers and select hotspot interface (LAN)>Step 3: Input a local address of 

the network.>Local Address of Network: Example: 192.168.15.1/24>Step 4: Input an 
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address pool of the network.> Address Pool of Network: Example: 192.168.15.2-

192.168.15.254>Step 5: Select a Hotspot Secure Sockets Layer (SSL) certificate.> Select 

Certificate: none>Step 6: Select a Simple Mail Transfer Protocol (SMTP) server.> IP Address 

of SMTP Server: Example of 0.0.0.0>Step 7: Setup a Domain Name System (DNS) 

configuration for the Hotspot server.> DNS Servers: Example of 8.8.8.8>Step 8: Input a 

Domain Name System (DNS) name of the local hotspot server.>DNS Name: Example of 

mdbabu.com>Ok. 

Step 9: Create a user profile for hotspot server. 

 

Figure 3.4.1.3: Hotspot User Profile 

Let's create a profile for the hotspot server.  First we have to go from IP to Hotspot then 

click on add button in user profile.  Select the name and address pool as required and 

click OK 

 

Step 10: Create a hotspot user. 
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Figure 3.4.1.4: Add Hotspot Users 

To create a hotspot user, first go from IP to hotspot and then click on user, select server 

from general options, select name, password, and profile as required, click on Apply. 

 

Step 11: Active user‟s details in hotspot connection 

 

Figure 3.4.1.5: Show Hotspot User 

Next on, “IP>Hotspot>Actives> Double-click on any one of the user's list and check this 

user information>Ok”. 
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Step 12: Connect user through hotspot. 

 

Figure 3.4.1.6: Hotspot Log In Panel 

Let's click OK with the username and password created in the Hotspot login panel 

Step 13: Hotspot connects successfully. 

 

 

Figure 3.4.1.7: Log in Success in Hotspot 
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3.4.2 PPPoE Server Configuration in Mikrotik Router: 

Step 1: Let's create an address list for Point-to-Point Protocol over Ethernet (PPPoE) 

server. 

 

Figure 3.4.2.1: Address List for PPPoE Server 

To create an address list, you must first go from IP to Address.  Then click on add, 

address, network, interface as required and then click OK. 

Step 2: Let's create a Point-to-Point Protocol over Ethernet (PPPoE) server. 

 

Figure 3.4.2.2: PPPoE Server 

To create a PPPoE server, first click on PPP to PPPoE server, then click on plus, then 

click OK with server name interface and authentication as required. 
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Step 3: Here the IP pool is created in Point-to-Point Protocol over Ethernet (PPPoE) 

server. 

 

Figure 3.4.2.3: Pool Configure for a PPPoE Server 

To create an IP pool, first you have to go from IP to Pool, then click on plus, then click 

Apply with the name and address as required. 

Step 4: Here the profile is created in Point-to-Point Protocol over Ethernet (PPPoE) 

method. 

 

Figure 3.4.2.4: Point-to-Point Protocol (PPP) Profile 

To create a profile, first click on profile, then from General Options, name, local address, 

remote address and DNS server as required and click Apply. 
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Step 5: Here,a user is created in Point-to-Point Protocol over Ethernet (PPPoE) method. 

 

Figure 3.4.2.5: Point-to-Point Protocol (PPP) Secret 

To create a user, click on secrets from ppp. Select the name, password, service and 

profile as required. Click on Apply. 

 

Step 6: Here is the queue types created. 

 

Figure 3.4.2.6: Queue Type for a PPPoE Server 

First someone clicks on the type plus plus a name in the type name, select PCQ in kind 

and select source address in classifier then apply OK  
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Let's create another queue type in the same way, select the destination address and click 

OK. 

Step 7: Here, the name and the specific IP range are inputted. 

 

Figure 3.4.2.7: Simple Queue for a PPPoE Server 

Clock the, "Queues>Simple Queues>General>‟+‟>Name: Example: Five_MB>Target: 

Example:192.168.100.0/25>Next step 

 

Step 8: Some of the required "Queue Types" have been selected. 



31 
© Daffodil International University 

 

Figure 3.4.2.8: Simple Queue of Advanced Option for PPPoE Server 

Next, "Queues>Simple Queues>Advanced>Queue Type: Five_MB_Q_UPl/ 

Five_MB_Q_Dow >Apply>Ok". 

 

 

3.4.3 Bind MAC Address: 

Step 1: Select the „reply-only‟ option for MAC binding. 

 

 

Figure 3.4.3.1: Interface to General Setting 
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Click on, "Interfaces>Select ether2 (LAN) and (Double click>General>ARP: reply-

only>Apply>Ok". 

 

 

Step 2: Enter Media Access Control (MAC) address in Address Resolution Protocol 

(ARP). 

 

Figure 3.4.3.2: Add Media Access Control (MAC) Address 

 

Click the, "IP>ARP> + >IP Address: 192.168.16.50> MAC Address: EC-A8-6B-70-0A-

5D>Interface: LAN Example: ether2>Apply>Ok". 
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CHAPTER 4 

Conclusion and Future Career & Opportunities 

 

4.1 Conclusion and Discussion: 

I have learned every configuration of a microtic router to properly provide internet 

service to every employee of a company and wanted to know how to build this network. I 

have been IP class. The main learning of this project is that the link can be configured in 

any way, it includes bay bandwidth control, Network address (NAT) configuring, 

networks guide my internship all control work control system and improved my position 

for efficient calendar home. There are many types of information in this internship that 

will help me to move forward. Improving the security system to keep the server secure 

and controlling the quality tests with Chaitali Update Programming. The method of the 

microtic operating system has been kept steady, confident and in a wide range of patients. 

Now, depending on the Internet network of several organizations it exists as a regular 

network design for an organization to talk about, Cannot manage Total Network. 

4.2 Future Career & Opportunities: 

Jobs are available in our country without skills.  The reason why an internship can make 

a big difference in my life is that here I can develop my scale so I chose the internship. 

So, this internship includes some of my previous experiences: 

 IT Support Specialist 

 IT Networking Specialist  

 Cyber security Specialist  

 Software & Web Developers 

 Data Specialist 
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APPENDICES 

 

Appendix:Company Information 

 

 

Head Office 

 

Name Prisma Digital Network Limited 

Address 34, Kemal Ataturk Avenue, Awal Center 

Level-3,Banani, Dhaka-1213 

Telephone 02-9857808, 9857811 

Fax 8900780 

Website www.prisma.net.bd 

Type of Organization Nationwide Internet Service Provider 

(ISP) 
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